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Notice to Purchaser

The Human T Cell Activation Cell and Cytokine Profiling Kit is a member of the Intellicyt product line 

that has been tested extensively for live cell analysis applications. These screening kits are validated 

as complete screening assays and are optimized for use in high content screening applications. 

Intellicyt’s building blocks and reagents are designed for flexibility in multiplexing and incorporation 

into screening assays. Intellicyt reagent kits are specifically formatted for optimal performance on 

Intellicyt Screening platforms.

This product is manufactured and sold by INTELLICYT CORPORATION for research use only. The kit 

and components are not intended for diagnostic or therapeutic use. Purchase of the product does 

not include any right or license to use, develop, or otherwise exploit this product commercially. 

Any commercial use, development or exploitation of this product without the express written 

authorization of INTELLICYT CORPORATION is strictly prohibited.

Limited Warranty

These products are offered under a limited warranty. The products are guaranteed to meet 

appropriate specifications described in the product insert at the time of shipment. Intellicyt 

Corporation will provide product replacement for valid claims. All claims should be made within five 

(5) days of receipt of order.

Trademarks and Patents

“Screening Solutions for Life” is a trademark of Intellicyt. Intellicyt, HyperView, HTFC, iDM, iQue, 

MultiCyt, ForeCyt, QBeads and Cy-Clone are registered trademarks of Intellicyt. Intellicyt’s product 

portfolio is covered by US and foreign issued and pending patents.
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List of Catalog Numbers

Description Cat. No

Human T Cell Activation Cell and Cytokine Profiling Kit 1x96 wells 90560

Human T Cell Activation Cell and Cytokine Profiling Kit 5x96 wells 90561

Human T Cell Activation Cell and Cytokine Profiling Kit 1x384 wells 90562

Human T Cell Activation Cell and Cytokine Profiling Kit 5x384 wells 90563

NOTE: The 1x 384-well kit has enough reagents to run 2x 96-well plates, NOT 
4x 96-well plates.

Kit Contents

Component Quantity Provided

Human IFNγ and TNFα Capture Beads (Pre-mixed) 1 vial

IFNγ and TNFα 2 Separate Standards                1 vial for each cytokine

Cytokine Detection Cocktail 1 bottle

Antibody Panel Detection Cocktail (Pre-mixed: 6 FL antibodies) 1 bottle

Cell Membrane Integrity Dye (R/Red) 1 vial

Wash Buffer 1 bottle

Cell Proliferation and Encoder Dye (B/Green) 1 vial

NOTE: A kit manual and a USB key with assay templates are also included the 
kit Package.
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Detection Channels

iQue Screener PLUS Detector Channels

Detector Spectrum
Violet Laser 
(405 nm)

Blue Laser 
(488 nm)

Red Laser 
(640 nm)

445/45 nm VL1 CD25    
(V/Blue)

530/30 nm VL2 BL1-H Prolif.
(B/Green)

572/28 nm VL3 CD8        
(V/Yellow)

BL2-H QBeads 

Det.

615/24 nm VL4 CD4       
(V/Orange)

BL3-H HLA-DR 
(B/Orange)

675/30 nm VL5
BL4-H RL1 Cell 

Viability 
(R/Red)

780/60 nm VL6 CD3         
(V/Crimson)

BL5_H CD69    
(B/Crimson)

RL2

NOTE: This assay is only compatible with the iQue® Screener PLUS with VBR 
option. Other iQue platforms including iQue Screener, iQue Screener PLUS 
(VYB lasers), iQue Screener PLUS (BR lasers) will NOT work with this assay due 
to the detection channel limitation.

BL1 channel:  Optional proliferation measurement with Cell Proliferation and 
Encoder Dye (B/Green) included with kit.

RL1 and RL2 channel: Classification of 2 QBeads (IFNγ and TNFα). The RL1 channel is 
also used for cell viability detection.
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Materials Needed but Not Provided

– Intellicyt iQue Screener PLUS platform with VBR Lasers

– Centrifuge capable of spinning microcentrifuge tubes and/or 15 mL conical 
tubes at up to 500g

– Centrifuge capable of spinning microplates

– Vortex mixer 

– Fresh complete cell culture media (Same media used to grow your sample cell 
culture) 

– 96 or 384 well assay plate (Example Source: Costar, Cat#3897 or Greiner 
Cat#781280)

– Microcentrifuge tubes and/or 15 mL conical tubes

– Reagent reservoirs (Example source: VWR, Cat#89094-680)

– Universal black lid (Example source: Corning, Cat#3935) or foil to protect 
from light/evaporation)

– 12-channel pipette reservoir (Example source: VWR, Cat#80092-466) (optional 
for preparing serial titrations)

– Appropriate liquid handler or multi-channel pipette (See Appendix F)

– Plate washer (such as BioTek model ELx405) 

– T cell activation reagents such as CD3/CD28 DynaBeads or Phytohemagglutinin 
(PHA) for use as positive control
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Introduction

The Human T Cell Activation Cell and Cytokine Profiling Kit was designed for ease 
of use in multiplexing cellular measurements and bead-based quantitation of 
secreted cytokines in the same assay sample. This optimized assay offers these unique 
advantages:

– Simultaneous measurement of cells and secreted cytokines. This assay is 
optimized to run on the iQue Screener PLUS (VBR configuration) which has a 
wide dynamic range without PMT adjustment, and enables high resolution of 
multi-color stained cells and multiplexed cytokine-detecting beads from the 
cell/beads mixture in each assay well. 

– Simultaneous measurement of T cell phenotypes, early and late cell 
activation markers in each phenotype, cell viability, cell count, and 
secreted effector cytokines. High content functional readouts profile T cell 
activation from multiple endpoints at the same time.

– Optimized workflow to enable measurement of high-level IFNγ/TNFα 
in the same assay well. The optimized workflow enables the measurement 
of high levels of IFNγ/TNFα generally observed in T cell activation cultures 
without sample dilution, while maintaining sufficient cell counts for 
phenotyping measurement.

– One-wash assay. As a multiplexed assay with multiple staining dyes, the 
one-wash assay workflow achieves excellent signal resolution with minimal   
hands-on time.

– The ability to multiplex T cell proliferation measurements along with the 
immunotyping and cytokine analysis. The kit provides the Cell Proliferation 
and Encoding dye (B/Green) to identify and measure the proliferative               
cell population.
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Assay Principles

The Human T Cell Activation Cell and Cytokine Profiling Kit is a cell/bead multiplex 
assay that simultaneously measures these endpoints:

– Immune cell phenotypes

– Early and late markers of T cell activation for each phenotype

– Secreted effector cytokines

– Cell count and cell viability 

In each assay well, live immune cells are distinguished from dead cells by staining 
with a fluorescent membrane integrity dye which enters only dead cells or those with 
a compromised membrane, staining the nucleic DNA by intercalation. Both late 
apoptotic cells and necrotic cells with compromised membranes will stain marking 
them for exclusion in further analyses. Live cells are immunophenotyped by staining 
with a fluorescent antibody panel to separate CD3+ T cells, CD3- non-T cells, 
CD3+CD4+ T helper cells, CD3+CD8+ T cytotoxic cells. The panel also includes 3 
different T cell activation markers: CD69 (early), CD25 (late), and HLA-DR (even later, 
with strong stimulation). Effector cytokines secreted by activated T cells, including 
Th1 cytokine IFNγ, and multifunctional cytokine TNFα (secreted mostly by CD8+ T 
cytotoxic cells and also by Th1 cells) are measured in a sandwich immunoassay 
format by 2 different QBeads® included in the same well.

Figure 1. Illustration of Human T Cell Activation Cell and Cytokine Profiling Kit assay 
principles. Different T cell phenotypes are profiled for the expression of 3 early/late activation 
markers: CD69 (early), CD25 (late), and HLA-DR (even later). *(May require strong stimulation such 
as TCR and CD28 co-stimulation). The 2 effector cytokines (IFNγ and TNFα) are also quantified 
in a 2-plex QBeads in a sandwich immunoassay format in the same assay well. Simultaneous 
measurement of T cell proliferation or encoded target cells is possible, but is not included in this 
illustration.
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Activation Panel Assay Workflow Overview 

Plate Cells

Optional:

Stain with Proliferation Dye 

(Green FL)

Endpoints

T Cell Activation 
Treatment

Transfer
Cell/Supe Mixture 

Samples

Incubate 

60 

Minutes

Incubate 

60 

Minutes

Incubate 

60 

Minutes

Add IFNγ/TNFα
Capture Beads

• Spin/Aspirate Supe
• Add 2Plex Cytokine    
   Detection Cocktail

Add FL-Ab 
Panel 
+ Cell 

Viability Dye
1 Wash 
@ Final

Read on iQue 
Screener PLUS (VBR)

• 15 minutes per 96-well plate
• 40 minutes per 384-well plate

T Cell ID
Cell Surface                         

Activation Markers
Secreted Effector 

Cytokines

CD3 CD4 CD8
CD69 
(Early)

CD25  
(Late)

HLA-DR    
(Even Later)

TNFα IFNγ

T Cytotoxic Cells + — + +/— +/— +/— + +/—

T Helper Cells + + — +/— +/— +/— +/— +(Th1)

Figure 2. Assay Workflow. T cells or immune cells such as PBMCs are activated in the culture 
plates. An aliquot of the cells/supernatant mixture from each well is transferred into assay plates 
along with IFNγ/TNFα capture beads. After incubating 60 minutes, the plate is centrifuged, the 
supernatant aspirated, and the cell/beads are resuspended in cytokine detection cocktail (anti-IFNγ, 
and anti-TNFα). After 60 minutes incubation, a fluorescent antibody panel cocktail with cell viability 
dye is added to the assay plate, including antibodies against CD3, CD4, CD8, CD69, CD25 and HLA-
DR, as well as a cell viability dye. After a 60 minute incubation, the assay plates are washed once 
before sample acquisition on the Intellicyt iQue Screener PLUS using the violet, blue and red (VBR) 
laser configuration. T cell and T cell subtypes, 3 cell surface activation markers expressed at different 
stages, and 2 secreted effector cytokines will be measured as the final readouts.  In the table, “+” 
means: highly expressed/secreted. “+/-” means: partially expressed/secreted. “-” means: low or no 
expression/secretion.

Please Note: If you want to measure T cell proliferation simultaneously, please stain the cells first 
in the test tube with the optional proliferation dye provided in the kit before plating cells in the 
culture plate with appropriate T cell activation treatment.
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Best Practices and Tips 

These best practices and tips will help ensure the success and accuracy of your assay.

Plate Type
The assay protocol described in this manual is designed for both a 96-well and 384-
well plate format. You can use one 384-well kit to run two 96-well plate assays.  
Intellicyt recommends the use of 96-well V-bottom plates (Costar, Cat#3897) for 96-
well plate assay, and 384-well V-bottom plates (Greiner, Cat#781280) for a 384-well 
plate assay. This assay kit provides ForeCyt templates for both 96-well and 384-well 
formats.

Manual Pipetting Recommendation
This protocol requires pipetting 5 µL volumes of liquid for a 384-well format. If you 
are pipetting manually instead of using an automatic liquid handler, be extra careful 
during the 5 µL volume transfer of the prepared reagent from the reservoir to the 
assay well with appropriate pipettes (See Appendix F). If the plate is empty, touch 
the tip to the well bottom and then release all the liquid to transfer 5 µL volume into 
the well. If the plate already has a reagent or sample in the wells, touch the pipette 
tip to the upper inner wall of the well at 45-degee angle before you release the 5 µL 
liquid. Touching the wall of the well prevents the 5 µL liquid droplet from hanging 
on the pipette tip instead of releasing into the assay well. A quick spin will force the 
newly dispensed reagent to the well bottom to mix with the existing reagent/sample 
already in the well.

This protocol also requires pipetting 10, 50, 90, 100 and 180 µL volumes of liquid for 
2 different plate formats. Change tips after manual pipetting to avoid cross-contam-
ination.

Shaking (for Quick Mixing)
This assay requires shaking to mix the sample/reagents. If you don’t have a separate 
shaker, you can use the one on the Intellicyt iQue screening system, as shown in 
Figure 3. (1) Click on Device in the menu bar. (2) Scroll down to Manual Control.  
(3) In the Manual Control window, use the arrows to set the RPM to 2000 (for brief 
mixing) or to 3000 (for more vigorous mixing after a spin down and aspiration). (4) 
As soon as you click On, the shaker will begin to shake and continue to shake until 
you click again to un-check. 
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Figure 3. Steps for using the shaker on the iQue screener PLUS. 

WARNING: Only perform a vigorous shake at 3000 rpm immediately after 
aspiration. Shaking at 3000 rpm with liquid in the wells will result in                          
cross-contamination. 

(See Appendix D) on mixing samples with the Intellicyt shaker.

Use a Plate Washer for Aspiration
For wash/aspiration steps, use an automated plate washer. Manual aspiration of 
plates and/or plate inversion techniques could result in severe sample loss. Aspira-
tion programs for this assay have been tested on a BioTek ELx405 Select. If you have 
a different plate washer brand or model, it is possible to approximate the aspiration 
settings on a different system. Appendix E provides recommended plate types and 
aspiration settings. 

Dilute Protein Standards with Fresh Culture Media 
It is critical to use FRESH CULTURE MEDIA to ensure the reproducibility and reliability 
of your data. Inaccurate or unexpected assay results can often be attributed to not 
following this best practice. Use fresh culture media to dilute the combined 2 protein  
standards provided in the kit. This media should be the same media you used to grow 
your culture sample. A specific diluent for protein standards dilution is not provided 
with this kit. 

This assay cannot be used to measure cytokines from human sera. If you need to 
measure the 2 cytokines from human sera, you may purchase QBeads kits from        
Intellicyt which provides special diluent for human sera samples and protein         
standards dilution.
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How to Make Sure Your Sample Cytokines are within the Linear Range of 
Standard Curves
This kit includes a template with standard curve layouts. ForeCyt uses 4PL with 1/Y2 
weighting for fitting the standard curves. At the log scale, ForeCyt can provide the 
linear range for each standard curve. 

Use a 1:3 serial titration with the top concentration at 50,000 pg/mL for each cyto-
kine. If you need to modify the top concentration, dilution factor, and the plate lay-
out for the standard, refer to the ForeCyt Reference Guide and make the adjustment 
in the Design tab. If a different culture media for the standard dilution is used it may 
have a slight impact on the standard curve and the linear range. For example, if you 
use RPMI1640 with 10% fetal bovine serum as fresh culture media for the standard 
dilution here is the expected linear range for each cytokine:

– IFNγ: 150-20,000 pg/mL

– TNFα: 200-50,000 pg/mL

NOTE: The detection range will be even wider than the linear range.

Generally, activated T cells secrete high levels of IFNγ and TNFα, depending on pa-
tient donor, cell density, cell health and cell proliferation. Since IFNγ and TNFα have 
a wide linear detection range, the assay workflow should not require any sample 
dilution. 

Here are two exceptions:

1. If you anticipate samples of IFNγ or TNFα at a level higher than the linear 
range, dilute your sample with your culture media before running the assay. 
Increase the sip time (described below) to acquire enough cell events.

2. If you anticipate your samples will have very low level of IFNγ (< 150 pg/mL) 
and TNFα (<200 pg/mL), refer to Appendix B to modify the assay workflow in 
order to extend the linear range of IFNγ and TNFα at the low end. 



7

Adjust the Sip Time to Acquire Enough Cell Events 

Sip time determines how many cell events are acquired from each well. The template 
in the kit has a default sip time of 4 seconds per well. Increase it to acquire enough 
cell events for your data analysis to reach statistical significance of your cell popula-
tion of interest. Sip volume per second varies slightly from machine to machine and 
even from day-to-day. Generally, it is about 1.5 µL per second. If you decide to use 
a longer sip time than the default 4-second sip time in the template, you also need 
to adjust inter-well shaking in ForeCyt Protocol. Tables 1 and 2 may help you adjust 
the sip time if necessary, assuming the lowest cell density in the culture plate is 1 
million/mL. 

If you anticipate that you will not have enough cell events even by increasing the 
sip time, increase the cell number acquisition from the assay plate by concentrating 
cells in the original culture/treatment plate (see Appendix C) before transferring cell/
supernatant mixture samples to the assay plate.  Refer to Appendix C to improve the 
precision of cell density calculation by running daily iQue volumetric calibration. If 
you have a cell attachment issue, Appendix C also provides recommendations about 
using cell-repellent plates or ultra-low binding plates to avoid cell attachment to the 
well bottom/wall.
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Table 1: Data Acquisition Adjustments for 96-well Format

Table 2: Data Acquisition Adjustments for 384-well Format

Sip Time 
Per Well

Cell Density 
in the Culture 

Plate

Transfer 
Volume

Final            
Volume After 
Resuspension                 
in Assay Plate

Estimated 
Cell Density 

in Assay Plate 

Estimated           
Volume Acquired             
(Assume1.5 µL/
second sip/well)

4s Sip 
(default) 1Million/Ml 

(Assumption: 
the lowest 

possible density 
~the seeding 

density)

10 µL (From 
Culture 
Plate to              

Assay Plate) 

~25 µL (20µL 
+ residual 
volume)

0.3 Million/mL 
(Assume wash 
causes 20%  

cell loss) 

6 µL

6s Sip 9 µL

8s Sip 12 µL

10s Sip 15 µL

12s Sip 18 µL

Sip Time 
Per Well  

Estimated Cell Events 
Aquired Per Well

Inter-well Shake 
Frequency

Inter-well 
Shake Duration

Aquisition Time 
per Plate 

4s Sip 
(default) 

1800 Every 6 Wells 4 seconds ~15 mins

6s Sip 2700 Every 6 Wells 6 seconds ~18 mins

8s Sip 3600 Every 4 Wells 8 seconds ~22 mins

10s Sip 4500 Every 3 Wells 10 seconds ~28 mins

12s Sip 5400 Every 3 Wells 12 seconds ~32 mins

Sip Time 
Per Well

Cell Density 
in the Culture 

Plate

Transfer 
Volume

Final            
Volume After 
Resuspension                 
in Assay Plate

Estimated 
Cell Density 

in Assay Plate 

Estimated           
Volume Acquired             
(Assume1.5 µL/
second sip/well)

4s Sip 
(default)

1Million/Ml 
(Assumption: 

the lowest 
possible density 

~the seeding 
density)

5 µL (From 
Culture 
Plate to             

Assay Plate) 

~15 µL (10µL 
+ residual 
volume)

0.3 Million/mL 
(Assume wash 
causes 20%  

cell loss) 

6 µL

6s Sip 9 µL

8s Sip 12 µL

Sip Time 
Per Well  

Estimated Cell Events 
Aquired Per Well

Inter-well Shake 
Frequency

Inter-well 
Shake Duration

Aquisition Time 
per Plate 

4s Sip 
(default)

1800 Every 6 Wells 4 seconds ~40 mins

6s Sip 2700 Every 6 Wells 6 seconds ~60 mins

8s Sip 3600 Every 4 Wells 8 seconds ~80 mins
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Cell Culture Preparation and Treatment
This assay is designed to detect T cell activation from cell culture. Before running the 
assay, you may need to prepare your immune cell culture with appropriate media 
and conditions. Low cell density may make it difficult to achieve statistical signifi-
cance for the cell population of interest.

– You may include recombinant human IL-2 protein (10 ng/mL) with in the 
culture media to help maintain the T cell health/growth. 

– Include negative and positive controls of T cell activation. You may use 
activation reagents such as CD3/CD28 DynaBeads or PHA or other appropriate 
reagents to stimulate T cell activation. The negative and positive controls will 
be useful to fine tune the gating of different activated T cell populations (See 
Data Analysis Section).

– If you plan to measure T cell proliferation, stain cells prior to cell culture 
using the Cell Proliferation and Encoding Dye (B/Green), provided in the kit.  
A detailed protocol for this optional cell staining procedure is found in 

 Appendix A.
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Assay Protocol Overview (96-well Plate)

Combine 2 different           
Lyophilized Standards into 

the same tube

Add 200µL FRESH CULUTRE 
MEDIA to solubilize

Note: Incubate RT 15 min.

Do 1:3 serial titration of 
Mixed Standards with Fresh 

Culture Media 

Dilute the pre-mixed IFNγ 
and TFNα Capture Beads 
with 18 times volume of                           
FRESH CULTURE MEDIA 

Add Cell Viability dye to 
Antibody Detection cocktail             

(1:500 dilution) 

Add 190µL/well pre-diluted 
IFNγ/TFNα Capture Beads. 

Do not Shake 

Incubate RT 1 hour, Dark

Add 10µL/well                   
Standards/Samples

Long Spin [300g, 5 min.] 
Aspirate supernatant

Re-suspend Cells/Beads in 
residual liquid with Strong 
Shake [3000 rpm, 60 sec.]

Add 10µL/well Cytokine 
Detection. Quick Spin | Brief 

Shake* 

Incubate RT 1 hour, Dark

Add 10µL/well Antibody 
Detection Cocktail with Cell 

Viability dye 

Quick Spin | Brief Shake*

Incubate RT 1 hour, Dark

Add 100 µL/well Wash Buffer 

Re-suspend Cells/Beads in 
residual liquid with Strong 
Shake [3000 rpm, 60sec.] 
Add 20µL/well Wash Buffer 

Long Spin 300g 5 min.       
Aspirate supernatant

*Quick Spin = 300 g, 5 sec. -Brief Shake = 2000 rpm, 20 sec. 
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Assay Protocol Overview (384-well Plate)

Combine 2 different                
Lyophilized Standards into 

the same tube

Add 200µL FRESH CULTURE 
MEDIA to solubilize

Incubate RT 15 min.

Do 1:3 serial titration of 
Mixed Standards with Fresh 

Culture Media 

Dilute the pre-mixed IFNγ 
and TFNα Capture Beads 
with 18 times volume of                           
FRESH CULTURE MEDIA 

Add Cell Viability dye to 
Antibody Detection cocktail             

(1:500 dilution) 

Add 95µL/well pre-diluted 
IFNγ/TFNα Capture Beads. 

Do not shake 

Incubate RT 1 hour, Dark

Add  5µL/well                   
Standards/Samples

Long Spin [300g, 5 min.] 
Aspirate supernatant

Re-suspend Cells/Beads in 
residual liquid with Strong 
Shake [3000 rpm, 60 sec.]

Add 5µL/well Antibody 
Detection Cocktail with Cell 

Viability dye 

Quick Spin | Brief Shake*

Incubate RT 1 hour, Dark

Add 50µL/well Wash Buffer 

Re-suspend Cells/Beads in 
residual liquid with Strong 
Shake [3000 rpm, 60sec.] 
Add 10µL/well Wash Buffer 

Long Spin 300g, 5 min.       
Aspirate supernatant

*Quick Spin = 300 g, 5 sec. -Brief Shake = 2000 rpm, 20 sec. 

R
ea

g
en

t 
P
re

p
ar

at
io

n
 

A
ss

ay
 S

et
u
p

A
ss

ay
 S

et
u
p

Add 5µL/well Cytokine 
Detection. Quick Spin | Brief 

Shake* 

Incubate RT 1 hour, Dark
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Before You Begin 

– Briefly centrifuge all vials before use to prevent reagent loss.

– Gently mix the dye with a pipette or briefly vortex prior to use.

– Vigorously vortex capture beads prior to use to ensure homogenous 
solution and consistent concentration in the assay. Beads tend to settle and 
aggregate over time. As with all things in life, mix them up occasionally. 
Ensure beads have not splashed onto the caps during this process.

The cell viability analysis of this assay is based on a different dye than 
traditional Trypan Blue-based viable cell measurement. The cell viability 
dye not only stains the necrotic cells but also the apoptotic cells. The vi-
able cell number may be lower in this assay than that in a typical Trypan 
Blue-based assay.

Reagent Preparation 

1.  Combine and Solubilize the 2 Lyophilized Cytokine Standards
 (IFNγ and TNFα) 

– There are 2 glass vials in the kit, one for each cytokine standard. Examine 
each vial to determine if the white sphere that is the lyophilized cytokine 
standard is at the bottom of the vial, or if it is stuck to the rubber lid 
(sometimes they hide up in there). If it is stuck to the lid, gently tap the 
glass vial against the workbench to force the sphere to fall to the bottom 
of the vial.  Only use 1 glass vial of each cytokine for the following standard 
preparation on each assay day.

– In order to combine the 2 standards, slowly and very carefully, open the 
rubber lids of each of the 2 vials to prevent the lyophilized cytokine spheres 
from flying out of the vial due to the slight positive pressure inside the vial. 
Combine the 2 lyophilized cytokine standard spheres into one tube. Combine 
in a 1.5 mL centrifuge tube or 15 mL conical tube by carefully pouring the 
sphere from the vial to the tube. Visually confirm that each sphere fell to 
the tube bottom. If not, tap the tube against workbench to force the sphere 
to fall to the bottom of the tube.

– Add 200 µL fresh culture media (the same media used to grow your sample 
culture) to the tube with the 2 lyophilized cytokine spheres.

– Do NOT mix. Let the spheres dissolve in the media for 15 minutes at room 
temperature. 

– After 15 minutes. Gently mix the cytokine standards by manually pipetting 
up and down 5-6 times to prepare standards for serial dilution. 
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2.  Prepare the 1:3 Serial Dilution of the 2 Cytokine Standards 
 (IFNγ and TNFα) 
The concentration for each cytokine in the combined cytokine solubilized mixture 
is 50,000 pg/mL. This will be the highest concentration in the following series of 1:3 
serial dilutions. 

– Prepare 12 microcentrifuge tubes (for 96-well plate assay format) or 16 
micro-tubes (for 384-well plate assay format). Label them #1 –#12 (for 
96-well plate assay) or #16 (for 384-well plate assay). You may also use an 
empty 96-well plate or 12-channel pipette reservoir instead of micro-tubes.

– To tubes # 2-12/16 add 100 µL of FRESH CELL CULTURE MEDIA. This is the 
same media used to grow your sample culture. After you have added the 
cell culture media, set aside the tubes until you are ready to make the serial 
dilutions by adding the standard to the micro-tubes containing the media.

– To tube #1, add 150 µL of the solubilized cytokine standard prepared in 
#2 above. It is the highest concentration standard (50,000 pg/mL for each 
cytokine) for the standard curve (top standard).

– From tube #1, remove 50 µL of standard, and transfer to tube #2. Gently 
pipette up and down at least 6 times to completely mix the solution. 

– From tube #2, transfer 50 µL volume to tube #3 and mix by gently pipetting 
the mixture up and down. Continue transferring and mixing until you reach 
the next to the last tube. Do not transfer any standard into tube #12 (for 
96-well plate assay) or #16 (for 384-well plate assay). Tube 12 or 16 will 
be the negative controls with zero cytokine standard.

96-well Plate Format

384-well Plate Format

Figure 4.  Preparation of Standard Curve. Dilute cytokine standards 1:3 in fresh tissue culture 
media. Use 12 samples (96-well) or 16 samples (384).  Note that the last sample for both formats 
contains media alone.
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About Standards

Figure 5 is an example of how to designate the cytokine standards on the plate in 
the Design tab of ForeCyt. Do NOT add the standard into the assay well until you are 
ready to begin the assay set up. When setting up your plate map in ForeCyt Design 
we recommend designating 1-2 rows of standard and arranging the standard wells 
from top to bottom and from low concentration to high concentration in 384 well 
plate; and, from left to right and from low concentration to high concentration in 
96 well plate. (A template with the standard design is already provided in the kit as 
shown in Figure 5 & 6.) You may change this configuration. Design -> Standards -> 
Edit Standard Set (Figure 6). Typical standard curves were also provided (Figure 7).

Figure 5. Arrange the standard wells from left to right (from low concentration to high concentra-
tion) in 96-well plate and from top to bottom (from low concentration to high concentration) in 
384-well plate. This design is included in the assay template provided in the kit USB drive.

Figure 6. Reverse Series to achieve a left to right (from low concentration to high concentration) 
in 96-well plate and top to bottom and (from low concentration to high concentration) in 384-well 
plate. Check the Set lowest concentration to zero checkbox. The assay template includes the reverse 
series and also set the lowest concentration at 0. If you use a different direction of series or if you 
do not include the lowest concentration at 0 as specified in the assay template, you may edit the 
standard set.

Figure 7. Representative standard curves (IFNγ and TNFα) with 1:3 serial dilutions. IFNγ linear range: 

150-20,000 pg/mL; TNFα linear range: 200-50,000 pg/mL.  
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3.    Dilute the Pre-mixed IFNγ/TNFα Capture Beads                                                     
The assay kit provides pre-mixed IFNγ/TNFα capture beads that require                  
dilution with fresh culture media. 

     –      Label a 50 mL conical tube, or a larger container such as bottle or                 
             reservoir, “Diluted Pre-mixed IFNγ/TNFα Capture Beads”. 

– Dilute the pre-mixed IFNγ/TNFα capture beads with a 18-fold volume of 
fresh culture media by transferring the precise volume to the appropriate 
container (See table below.)

– Vigorously vortex the container for 10 seconds. If you dilute the beads in a 
reservoir, you may use manual pipetting to mix the beads.

Pre-Mixed 
IFNγ/TNFα
Capture Beads

Fresh Culture Media
(18-fold Volume)

1 x 96 wells 1.15 mL 20.7 mL

1 x 384 wells 2.3 mL 41.4 mL

5 x 384 wells    11.5 mL 207.0 mL

4.    Add the Cell Membrane Integrity Dye (R/Red) into the Antibody Panel Cocktail
The assay kit provides a separate vial of Cell Membrane Integrity Dye (R/Red) at a 
500x concentration to measure cell viability. Add the Cell Membrane Integrity Dye 
(R/Red) into the vial/bottle with the Antibody Panel Detection Cocktail right before 
the assay. Use the following table for dye amounts. After dye addition, mix the dye 
by manually pipetting the solution up and down 5 times.

Cell Membrane 
Integrity Dye (R/Red)
(500x)

Antibody Panel Detec-
tion Cocktail (Volume in 
Original Vial/Bottle)

1 x 96 wells 2.5 µL 1.25 mL

1 x 384 wells 5 µL 2.5 mL

5 x 384 wells    25 µL 12.5 mL
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96-Well Plate Assay Set Up
In this one-wash assay you will use the serially diluted cytokine standards for 
quantitation of 2 cytokines (IFNγ and TNFα) in the sample. This will generate 2 
standard curves to determine the cytokine concentration in the sample (Figure 7).  

NOTE: For more accurate population gating and subsequent data analy-
sis we strongly recommend using stimulation reagents such as CD3/
CD28 DynaBeads or PHA or other appropriate reagents for positive and                
negative T cell stimulation in wells of the original culture plate. 

Total Protocol Time: 3 hours 
Total Hands-On Time: Approximately 30-60 minutes

1. Add Cell/Supernatant Mixture Sample and 2-plex Cytokine Standards    

– Mix the cell/supernatant mixture in the original culture plate 10 times with 
a pipette to break up cell aggregates and to resuspend the cells. Be careful 
not to introduce bubbles in the samples. Transfer 10 µL of cell/supernatant 
sample to each well of the assay plate you designated as Sample when you 
set up your plate in the ForeCyt Design tab.

– Transfer 10 µL cytokine Standards prepared earlier to each well of the assay 
plate you designated for Standards in the ForeCyt Design tab. 

2. Add the Pre-diluted Pre-mixed IFNγ/TNFα Capture Beads Prepared Earlier

– Vigorously vortex the pre-diluted pre-mixed IFNγ/TNFα capture beads 
prepared earlier. Transfer all the beads to a reservoir. Add 190 µL of beads 
to each assay well. Agitate the beads occasionally during the transfer of the 
beads to the plate to prevent the beads from settling. 

NOTE: During the liquid transfer, change the tip to avoid cross-well 
contamination.

– Cover the plate to prevent evaporation and protect from light. Incubate 
the plate at room temperature for 60 minutes. Do NOT shake the plate to 
prevent the liquid volume in assay wells from splashing into adjoining wells. 

3. Spin/Aspiration/Agitation

– After incubation, spin the assay plate (300g, 5 minutes). Aspirate the 
supernatant with a plate washer, following the manufacturer’s instructions. 
Agitate the sample in the residual liquid in the plate on the iQue plate 
shaker (3,000 rpm, 60 seconds).
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4. Add Cytokine Detection Cocktail

– Transfer all the Cytokine Detection Cocktail to a reservoir. Add 10 µL/well 
cytokine detection cocktail to the assay plate.

– Do a quick spin of the plate (300g, 5 seconds) to ensure that all samples are 
at the well bottom and not attached to the well sides.

– Mix the plate for 20 seconds at 2,000 rpm using the iQue plate shaker to 
ensure thorough mixing. 

– Cover the plate to prevent evaporation and protect from light. Incubate the 
plate at room temperature for 60 minutes. 

5. Add Antibody Panel Detection Cocktail with Cell Viability Dye

– Transfer all the antibody panel detection cocktail with cell viability dye 
prepared earlier to a reservoir. Add 10 µL/well antibody panel detection 
cocktail with cell viability dye to the assay plate.

– Do a quick spin of the plate (300g, 5 seconds) to ensure that all samples are 
at the well bottom and not attached to the well sides.

– Mix the plate for 20 seconds at 2,000 rpm using the iQue plate shaker to 
ensure thorough mixing. 

– Cover the plate to prevent evaporation and protect from light. Incubate the 
plate at room temperature for 60 minutes. 

6.  Wash/Resuspension

– Add 100 µL/well of wash buffer provided in the kit to the assay plate.

– Spin the assay plate (300g, 5 minutes). Aspirate the supernatant in the assay 
plate with a plate washer, following the manufacturer’s instructions. Agitate 
the sample in the residual liquid in the well (3,000 rpm, 60 seconds) using 
the iQue plate shaker.

– Add 20 µL/well wash buffer. Do a quick spin of the plate (300g, 5 seconds) to 
ensure that all samples are at the well bottom and not attached to the well 
sides.

– The samples are now ready for acquisition on iQue Screener PLUS (VBR) 
platform.
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384-Well Plate Assay Set Up
In this one-wash assay you will use the serially diluted cytokine standards for 
quantitation of 2 cytokines (IFNγ and TNFα) in the sample. This will generate 2 
standard curves to determine the cytokine concentration in the sample (Figure 7).  

NOTE: The following assay setup includes brief shaking in steps 4 and 5 
(2,000 rpm for 20 seconds) and strong shaking in steps 3 and 6 (3,000 
rpm for 60 seconds). WARNING: Make sure that the rpm for these 
shakes are correct to avoid cross-well contamination.

Total Protocol Time: 3 hours 
Total Hands-On Time: Approximately 30-60 minutes

1. Add Cell/Supernatant Mixture Sample and 2-plex Cytokine Standards    

– Mix the cell/supernatant mixture in the original culture plate 10 times with 
a pipette to break up cell aggregates and to resuspend the cells. Be careful 
not to introduce bubbles in the samples.  Transfer 5 µL of cell/supernatant 
sample to each well you designated as Sample in the assay plate when you 
set up your plate in the ForeCyt Design tab.

– Transfer 5 µL cytokine Standards prepared earlier to each well designated for 
Standards in the assay plate. 

2. Add the Pre-diluted Pre-mixed IFNγ/TNFα Capture Beads Prepared Earlier

– Vigorously vortex the pre-diluted pre-mixed IFNγ/TNFα capture beads 
prepared earlier. Transfer all the beads to a reservoir. Add 95 µL of beads to 
each assay well in the assay plate. Agitate the beads occasionally during the 
transfer of the beads to the plate to prevent the beads from settling. 

– Cover the plate to prevent evaporation and protect from light. Incubate 
the plate at room temperature for 60 minutes. Do NOT shake the plate to 
prevent the liquid volume in assay wells from splashing into adjoining wells. 

NOTE: During the liquid transfer, change the tip to avoid cross-well 
contamination.

3. Spin/Aspiration/Agitation

– After incubation, spin the assay plate (300g, 5 minutes). Aspirate the 
supernatant with a plate washer, following the manufacturer’s instructions. 
Agitate the sample in the residual liquid in the plate using the iQue plate 
shaker (3,000 rpm, 60 seconds).
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4. Add Cytokine Detection Cocktail

– Add 5 µL/well cytokine detection cocktail provided in the kit to the assay plate.

– Do a quick spin of the plate (300g, 5 seconds) to ensure that all samples are 
at the well bottom and not attached to the well sides.

– Mix the plate for 20 seconds at 2,000 rpm using the iQue plate shaker to 
ensure thorough mixing. 

– Cover the plate to prevent evaporation and protect from light. Incubate the 
plate at room temperature for 60 minutes. 

5. Add Antibody Panel Detection Cocktail with Cell Viability Dye

– Transfer all the antibody panel detection cocktail with cell viability dye 
prepared earlier to a reservoir. Add 5 µL/well antibody panel detection 
cocktail with cell viability dye to the assay plate.

– Do a quick spin of the plate (300g, 5 seconds) to ensure that all samples are 
at the well bottom and not attached to the well sides.

– Mix the plate for 20 seconds at 2,000 rpm using the iQue plate shaker to 
ensure thorough mixing. 

– Cover the plate to prevent evaporation and protect from light. Incubate the 
plate at room temperature for 60 minutes. 

6. Wash/Resuspension

– Add 50 µL/well wash buffer provided in the kit to the assay plate.

– Spin the assay plate (300g, 5 minutes). Aspirate the supernatant with a plate 
washer, following the manufacturer’s instructions. Agitate the sample in the 
residual liquid in the well (3,000 rpm, 60 seconds).

– Add 10 µL/well wash buffer to the assay plate. Do a quick spin of the plate 
(300g, 5 seconds) to ensure that all samples are at the well bottom and not 
attached to the well sides.

– The samples are now ready for acquisition on iQue Screener PLUS (VBR) 
platform.
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Sample Acquisition and Data Analysis

1. Launch ForeCyt. 

2. If you have not already imported the template provided by Intellicyt, import it 
now. Create a New Experiment using the template. 
Adjust the sip time if necessary to achieve the statistical significance for your 
cell population of interest. 
Define your T cell activation positive wells and negative wells in the Design tab 
in ForeCyt after importing the template. This is important for later data analysis 
and for fine-tuning the gating of activated T cell populations.

3. The template gates are pre-set for different populations. Here are the gating 
details if you want to manually draw the gates or fine tune the existing gates 
from the template:

Gate Cells/Beads from All Events:

NOTE: If you have used CD3/CD28 DynaBeads in the culture, make sure not 
to include DynaBeads in “Cells” gate. DynaBeads are much smaller in FSC-H 
and in SSC-H plot than cells and beads used for cytokine detection.
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Gate Different Cell Phenotypes/Activated Cells from Live Cells:
(Manually adjust the linear range of bi-exponential scale in the dot plots, if neces-
sary, to improve the separation of different populations)

Use the Positive/Negative Control Wells to Fine Tune the Gates of Activated Cells. 
(Example: Gate CD69+ Cells in CD4+ T Cells in an Overlay Plot with Positive Wells 
and Negative Wells)
 

NOTE: You have to assign positive and negative wells in the Design tab    
in ForeCyt.
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Compensation Matrix

The template already includes the compensation matrix. It is not neces-
sary to adjust any compensation matrix even if you use the optional Cell 
Proliferation and Encoding Dye (B/Green) in the assay.
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Appendix A: Optional Proliferation and Encoder Dye Protocol

This following protocol uses the Cell Proliferation and Encoding Dye (B/Green) 
to multiplex T cell proliferation measurement into the assay. The assay template 
provided on the USB drive in the kit already includes the compensation matrix for 
the dye detection channel (BL1 in iQue Screener PLUS with VBR configuration). 
Below are instructions for using the optional proliferation/encoding dye to stain your 
T cells (for proliferation measurement) or to stain your target cells:

1. Before beginning, ensure the dye is completely thawed. If necessary, place the 
dye vial in a 37 degrees Celsius water bath for 5-10 minutes before use.

2. Prepare dye stock by diluting the Proliferation and Encoder dye provided in the 
kit into HBSS buffer or PBS buffer (dilution factor 1:1250). The HBSS or PBS 
buffer must be protein-free. Select one buffer and use it consistently across 
the assay protocol when it is required.

3. Collect your T cells or target cells in a 50 mL conical tube. Spin cells down 
(500g, 5 minutes) and remove the original culture media.

4. Re-suspend cells in 20 mL protein-free HBSS or PBS. Spin cells down (500g, 5 
minutes). Remove the supernatant. Re-suspend cells in protein-free HBSS or 
PBS to 1-4 million/mL.

5. Combine an equal volume of the prepared cells and the prepared dye stock. The 
final dye concentration in the staining tube will be 1:2500 diluted. Mix gently 
and incubate cells at room temperature for 15 minutes, cover the plate to 
prevent evaporation and protect from light. 

TIP: Thoroughly mix the cell/dye mixture carefully. Avoid cells or dye 
droplets attaching to the inner wall of the tube which may result in 
inconsistent cell staining. 

6. After staining, wash by adding at least 2x volume of complete culture media 
(with 10% serum) to the staining sample. Spin (500g, 5 minutes). Remove the 
supernatant. Resuspend cells manually in the residual liquid.                                

7. Repeat Step 6 two more times.
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8. After the final wash, carefully re-suspend cells to the desired cell density for 
your culture/assay. For T cell proliferation positive control, you may need 
to add T cell activation reagents (such as CD3/CD28 DynaBeads (1:1 cell/
bead ratio) or PHA (10 µg/m) to stimulate the T cells. The following example 
illustrates gating the proliferated cells acquired by iQue Screener PLUS (VBR) 
after 5-day culture. No compensation adjustment is required.
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Appendix B: Modifying Assay Workflow to Handle Samples 
with Very Low Levels of IFNγ and TNFα
If you expect your samples will have very low levels of both IFNγ (< 150 pg/mL) and 
TNFα (<200 pg/mL), you may make adjustments in the assay workflow by simpli-
fying the protocol to extend the linear range of IFNγ and TNFα at the low end.              
Recommendations are below:

1. Eliminate Reagent Preparation: Step 3: The original assay protocol specifies 
diluting the pre-mixed IFNγ/TNFα capture beads with 18 times volume of fresh 
culture media. You should bypass this dilution step. Do NOT dilute the pre-
mixed IFNγ/TNFα capture beads provided in the kit.

2. Consolidate Plate Assay Setup Steps 1-3 as shown below:

A. For 96-well assay format: 

1) Add 10 µL/well Standards/Samples. 

2) Add 10 ul/well of the pre-mixed IFNγ/TNFα capture beads to the 
assay plate.  Quick spin (300g, 5 seconds). Brief shake (2,000rpm, 20 
seconds). Incubate at room temperature for 1 hour with lid on and 
without light.  

3) Add 180 µL/well fresh culture media to each well. Spin the plate 
(300g, 5 minutes). Aspirate the supernatant. Re-suspend cell/beads 
in the residual liquid in the assay plate by strong shake (3,000rpm, 
60 seconds).

4) Continue the assay by following the 96-well Plate Assay Setup 
Steps 4-6.

B. For 384-well assay format: 

1) Add 5 µL /well Standards/Samples.

2) Add 5 µL/well the pre-mixed IFNγ/TNFα capture beads in the assay 
plate. Quick spin (300g, 5 seconds). Brief shake (2,000rpm, 20 
seconds). Incubate at room temperature for 1 hour with lid on and 
without light.

3) Add 90 µL /well fresh culture media to each well. Spin the plate 
(300g, 5 minutes). Aspirate the supernatant. Re-suspend cell/beads 
in the residual liquid in the assay plate by strong shake (3,000 rpm, 
60 seconds).

4) Continue the assay by following the 384-well Plate Assay Setup 
Steps 4-6.
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Appendix C: Options for Improving Cell Event Acquisition

Option 1: Concentrate Your Cell Samples in the Original Culture Plate if Cell 
Density Is Low

If after increasing the sip time in Sampling Protocol you still did not get enough cells 
during sample acquisition, follow the steps below before running your next assay: 

– Spin your cells down (300 g, 5 minutes) in your original T cell culture 
plate. 

– Remove half or two thirds the volume of supernatant to double or triple 
cell density in the culture well. Then, re-suspend your cells in the original 
culture plate in the remaining supernatant by manually pipetting the 
sample up and down (5-6 times). 

– Transfer the concentrated cell samples into the assay plate before 
running the assay.

Option 2: Run Daily Volumetric Calibration to Get More Precise Cell Density Data

The Intellicyt iQue Screener PLUS cannot directly perform absolute cell counting 
due to the slight variation of acquisition volume. Variations may be a result of 
tubing change, tubing wear, and system cleanliness. The acquisition volume may 
also vary machine-to-machine and day-to-day. If you require very precise cell 
density information, we recommend running a daily volumetric calibration on your 
iQue Screener PLUS using absolute counting beads such as SPHERO™ AccuCount 
Particles (Spherotech, Cat#ACBP-50-10) to do the volumetric measurement on 
the iQue Screener PLUS. This bead has an absolute count per volume unit. Follow 
the Spherotech protocol to mix and transfer the beads to a testing plate.  We 
recommend running the exact same sampling protocol with the same sip time, 
the same plate type, and the same volume in the well as used in this Human T Cell 
Activation Cell and Cytokine Profiling Kit. You may only need to run 3-4 wells 
of AccuCount beads at the beginning of your assay to measure the sip volume 
on your iQue Screener PLUS. Use this volume measurement on the same day of 
the experiment in which you wish to calculate the cell density. Adjust your final 
calculation by considering the sip time (in ForeCyt Protocol) and the dilution factor 
of your sample in the final assay reaction volume. 

ForeCyt Advanced Metrics, Custom Function (Metrics -> Add -> Add Advanced 
Metric -> Custom) can automate the calculation much like entering a calculation 
into a spreadsheet. If you are not familiar with how to use the custom function, click 
ForeCyt -> Help -> Reference Guide for more information or call customer support.
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Option 3: Use Cell-repellent or Ultra-low Binding Plates to Prevent Cell 
Attachment

T cells usually will not attach to the well bottom/wall of the Intellicyt-recommended 
plates (96w plate,Costar, Cat#3897; 384w plate, Greiner, Cat#781280). However, 
under some user defined biological conditions, some or all of your sample cells 
may partially attach to the assay well bottom/wall resulting in inconsistent cell 
count. For these situations we recommend using the Greiner cell-repellent plate 
(e.g., Cat#651970, Cat#781970) or Corning ultra-low binding plate (e.g., Cat#7007, 
Cat#4516) in order to achieve a more precise cell counting on the iQue Screener 
PLUS. If ForeCyt does not list this plate model, add it to the list (Device —> Manage 
Plate Models —> Add) and map it.
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Appendix D: Mixing Samples with the Intellicyt Shaker

iQue Screener PLUS (VBR)

Plate Type Well Volume MAX RPM

96-Well 20–40 µL 2600

96-Well 40–60 µL 2200

96-Well 60+ µL A/O*

384-Well 10–30 µL 3000

384-Well 30–50 µL 2800

384-Well 50+ µL A/O*

*A/O = Additional Optimization necessary. While it is possible to run these volumes, they were not 
routinely tested by the assay development team. To determine ideal shake speeds for high volume 
assays, Intellicyt recommends starting at low RPM values and slowly increasing to higher RPM values.
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Appendix E: Plate-type Recommendations and Automated 

Wash Protocols for Microplates

The following plate types and aspiration settings have been extensively tested with 
Intellicyt assay products.

Plate Type Well Type Manufacturer     
Manufacturer 
Product #

384-well V-bottom Greiner 781280

96-well V-bottom Costar 3897

  

When using the above plate types, the following aspiration programs have been 
tested on a BioTek ELx405 Select. 

Intellicyt recommends that wash protocols use an automated plate washer. Manual 
aspiration of plates and/or plate inversion techniques could result in severe sample 
loss.

Plate Type
Aspiration 
Height 
Setting

Aspiration 
Height 
Offset    

Aspiration 
Rate 
Setting

Aspiration 
Rate

384-well,       
V-bottom

#31 3.937 mm #6 15 mm/sec

96-well, 
V-bottom

#40 5.08 mm #6 15 mm/sec
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Appendix F: Liquid Handler Recommendations

Intellicyt recommends the following liquid handlers:

12-channel pipette for manual transfer of liquid to the plate:

– Manual 12-channel pipette, Tacta, 5-120 µL (Sartorius);

– Manual 12-channel pipette, Tacta, 30-300 µL (Sartorius);

– Electronic 12-channel pipette, Picus, 5-120 µL (Sartorius);

– Electronic 12-channel pipette, Picus, 10-300 µL (Sartorius).

Single-channel pipette for reagent preparation:

– Manual single-channel pipette, Tacta (Sartorius);

– Electronic single-channel pipette, Picus (Sartorius).

Automated liquid handler for dispensing, if necessary:

– Personal Pipettor, 96 or 384 channels (Apricot Designs);

– MicroFlow Select, 8 channels (BioTek).
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Appendix G: FAQ

Q1: Can I apply the standard curves acquired from one day to another day’s 
experiment for cytokine quantitation?

Answer: It is possible to do that in ForeCyt software. However, there is potential 
day-to-day variation that may affect your cytokine quantitation if you use standards 
curves acquired on different days. We recommend running standard curves test on 
each assay day and applying the standard curves to experiment run on the same 
day. You may include the standards in each of your assay plates, or you may run a 
stand-alone standard plate and then apply standard curves to the assay plates run on 
the same day for cytokine quantitation. If you have in-plate standards, the cytokine 
quantitation is automatic with the assay template. If you run a stand-alone standard 
plate, you can share the fit (the standard curve) before you do the cytokine calcula-
tion on your assay plate by either “copy analysis” or by using the advanced metrics in 
the assay plate. If you don’t know how to use this feature, refer to the ForeCyt Refer-
ence Guide for information on the Share Fit feature, or contact Intellicyt customer 
support.

Q2: Can I fix my samples in the plate with fixatives?

Answer: It is possible to fix the cell samples with fixatives such as 1% PFA. However, 
you may need to validate it against your biology. Don’t use methanol to fix the 
sample as it affects bead-based cytokine detection. In contrast, 1% PFA fixation does 
not affect bead-based cytokine measurement. Fixation and further wash steps may 
cause cell loss and affect the final event acquisition of your assay. So we recom-
mend additional optimization. If you see significant cell loss, you may transfer your 
samples out of your original assay plate, and perform the fixation in a new plate. A 
cell-repellent plate (Greiner, Cat#651970, and Cat #781970) may reduce cell loss due 
to fixation or fixation-related cell cross-link to the well bottom.

Q3: Do I need to dilute my samples for the assay if my samples have high level 
of cytokines? 

Answer: The assay is built to measure relatively high level of IFNγ (as high as 20,000 
pg/mL) and TNFα (as high as 50,000 pg/mL) without sample dilution. In addition, 
there is 1 alternative workflow that don’t require sample dilution (see Appendix B) 
and can measure low level of IFNγ and TNFα (IFNγ<150 pg/mL, TNFα < 200 pg/mL.). 
If your samples have the cytokines higher than the expected linear range, consider 
diluting your samples. After you dilute your samples, you may need to adjust the sip 
time in Protocol in ForeCyt to acquire enough cells for data analysis.



32

Q4: The cell count is too low. How do I acquire more cells?

Answer: Increase the sip time in the Protocol in ForeCyt to ac-
quire more cell events. The default sip time in the assay tem-
plate is 4 seconds. You may increase the sip time to acquire more cells                                                                                                                
(See the table/recommendation in Section- Best Practices and Tips).

If you estimate that you still can’t get enough cell events, even by increasing the sip 
time, follow the recommendation in Appendix C to concentrate your cell samples in 
a future assay.

Q5: Can I use 1x 384-well kit to run 96-well plate assay? How many 96-well 
plates can I run?

Answer: Yes. A 1x 384-well kit can be used for 2 assay plates in a 96-well format. 
The assay kit, regardless of format, provides a USB drive with assay templates for 
both 384-well format and 96-well format. Choose the appropriate assay format for 
your need. 1x 96-well kit provides 1 vial of standard protein for each cytokine. 1x 
384-well kit provides 1 vials of standard protein for each cytokine. Additional stan-
dards are also available for purchase.

Q6: Can I multiplex this assay with other cellular or cytokine endpoints?

Answer: We recommend not multiplexing this assay with other cellular or cytokine 
endpoints. However, it is possible to use the optional proliferation/encoder dye pro-
vided in the kit to multiplex the T cell proliferation or the target cell measurement. 
The compensation metrics included in the assay template already considered this 
multiplex measurement. No additional compensation adjustment is needed.

Q7: Why do I get very few beads and/or cells from the sample in data acquisi-
tion?

Answer: Generally, if you have very few beads and cells from sample acquisition, 
you can always increase the sip time and re-read the plate on iQue Screener PLUS. 
Usually you will get more than 50 beads for each bead population in each well. If 
you see very few beads per bead population per well, there may be several causes: 
You did not agitate the original beads vial very well. The beads were not mixed in 
reservoir during the transfer. The sample was not agitated in the residual buffer in 
the assay plate after spinning/aspiration and the beads settled to the well bottom. 
The beads were washed away during the aspiration of the supernatant from the as-
say plate after spinning. 

If you get significantly fewer cells than you expected, there are several causes: Biol-
ogy affected cell growth/viability. The cells were not mixed before transferring cell/
supernatant sample from the culture plate to the assay plate. The sample was not 
agitated in the residual buffer in the assay plate after spinning/aspiration and cells 
settled at the well bottom. Cells were washed away during the aspiration of the 
supernatant after spinning.
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Q8: The CD4 and CD8 signal in the dot plot show as smears rather than discreet 
populations. Can I adjust the plot and the gating?

Answer: The assay template included a phenotype 2D plot with CD4 at the X-axis 
and CD8 at the Y-axis. The plot is biexponential scale. You may need to adjust the 
linear range of the biexponential scale manually by increasing or decreasing 2-10 
times of the linear range value. Choose the one that can get the visualization of sig-
nal separation of CD4+ and CD8+ cells. Then, you could adjust the gating to include 
the corresponding T cell subpopulations. As a reminder, T cell activation may affect 
the donor-dependent expression of CD4 and CD8 proteins. This is why you might 
sometimes see some smears of cell populations such as CD8+ cells. You may create a 
plate view to visualize the well-based 2D plot to see more details in CD4/CD8 signal 
separation.

For Technical Support Contact Us at:

Email: support.intellicyt@sartorius.com                                                                          
Telephone: 505.345.9075, Option 2



34

ABOUT THE COVER:  

Native to the Desert Southwest, Desert 

Globemallow (Sphaeralcea ambigua) is highly 

drought-resistant perennial that often grows in 

large clumps, reaching a height of between 20 

and 40 inches. It favors sandy washes and rocky 

hillsides and can be important food and cover for 

desert tortoises. Hummingbirds adore it. Desert 

Globemallow blooms sporadically from spring 

to autumn with spectacular bursts of flowering 

after rain. Medicinal properties are said to include 

toning the immune system, healing soft tissue 

injuries and reducing inflammation.   
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